
OCTOPUS 
Demonstration Copy - Quickstart Guide

Please note that this Quickstart Guide for using the demonstration copy of Octopus will give
you only a brief introduction to using the main functions. More detailed guidance will be found

in the User Guide and Manual for the full version.
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1 Before you start...

1.1 Software Licence Agreement

Please read the terms and conditions of the Software Licence Agreement which relate to the 
use of this software. The Software Licence Agreement can be found on page 24 of this 
Quickstart Guide. You should read the Agreement before you install the software on your 
computer.

The Software Licence Agreement also appears as part of the installation program. If you have 
not read page 24 of this Quickstart Guide, you should take the time to read the Agreement 
when it appears on your screen during installation.

1.2 Familiarity with Windows...

Octopus is a Windows-compatible product, designed to operate in much the same way as other
Windows applications. If you are not familiar with Windows software, you should refer to 
your Windows documentation and/or tutorial to familiarise yourself with some of the standard 
Windows functions (such as pointing and clicking on the mouse buttons, moving around 
menus and submenus, opening and closing windows, etc).

These basic operations are standard to Windows applications, and there is no point in 
duplicating information here which is already covered in your Windows documentation;  this 
manual assumes that users have a working knowledge of using Windows-based software. 

Remember, you can get help by pressing the F1 key, or choosing from the Help menu.

1.3 About Octopus

Octopus contact and activity navigation software makes it easy for you to work more 
productively and more efficiently. In seconds, you can schedule meetings and appointments - 
both for yourself and for other users on your network - and view your job list for the day (or 
week, or month). You can record and review details on the customisable database, and track 
activities associated with each database contact, like meetings, calls and correspondence. With
a modem installed on your computer, you can dial any contact automatically by using the 
telephone icon on the toolbar, or just as quickly export their address details to a mail merge 
file in your word processing software.

For important meetings or telephone calls, you can set alarm messages to alert you in advance 
of the critical time. These messages appear on your screen even when you are not working in 
Octopus, making sure that you are never caught unprepared.

Networked users can also send automatic Email notifications to other users, and assign 
activities to them - Octopus will automatically update their To Do lists so that important tasks 
are not neglected or forgotten. You can flag individual records with urgent messages (for 
example, relating to credit holds or special payment terms) that pop up whenever any user 
views the record - helping you to maintain effective credit control and stay up to date with the 
latest developments.

Please note that this software is only a demonstration copy, and therefore some functions 
(such as report creation and printing) are included only in a restricted form.
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2 System requirements 

If you want to send automatic notifications of completed actions to other users on your 
network, you must have a MAPI-compliant mail system (eg; Microsoft Mail) installed on your 
system.

If you want to use the AutoDial function, you will need to have a Hayes-compatible modem 
installed on your computer.

If you want to print reports, you will need to have a printer connected to your computer. 
Please note that the reporting capabilities of this demonstration software are restricted. A 
basic sample report has been included for illustration purposes only.

2.1 Stand-alone IBM compatible PC

Hardware:
8MB RAM
486DX 33MHz processor (recommended)
15MB hard disk space (minimum)
VGA graphics controller (minimum); (SVGA is recommended)
1 x 3.5” floppy diskette drive
Windows-compatible mouse

Software:
Windows V3.1 (or above)
DOS V6.0 (or above)

Optional:
Hayes-compatible modem
MAPI-compliant mail system
MS Word for Windows V6.0 (or above)
MS Excel V5.0 (or above)
Printer

2.2 Network server

Any fileserver with a minimum of 15MB spare space, running Novell 3.11 or above or 
Windows for Workgroups.

2.3 Network workstation

Requirements are as for the stand-alone machine detailed above.
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3 Installation
3.1 Stand-alone computer

1 Please check that you have received 3 Octopus diskettes numbered 1 - 3. Start your system 
running Windows. If you see the C prompt (C:\) when you turn your computer on, type WIN

2 Insert Octopus diskette number 1 into the floppy drive

3 From the File menu, choose Run...

4 At the Command Line prompt, type: A:\setup, and press ENTER. (You will be asked to accept
the terms of the Pre-Release Agreement, as shown on page 24 of this Quickstart Guide. If you 
do not wish to accept the terms of this Agreement, you should return the software and all 
accompanying documentation to KAI Computer Services Limited - our address is shown on 
the front cover). Octopus will prompt you for the user name and the company name

5 The screen above will ask you which type of installation you require, stand-alone or PC 
network. Click on the icon box displaying the appropriate installation. Press the Continue 
buttons which appear while you are installing Octopus to complete the installation. If you 
press the Exit button(s) at this stage, Octopus will not be loaded on to your computer

6 Octopus will create its own directories on your hard disk for installing the program and the 
associated data files. If you want to install it into a different directory from the one shown, 
choose the Select Directory buttons as shown in the illustration below, and type in your 
preferred directory paths in the appropriate boxes
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7 Notice that the boxes are automatically checkmarked to install Octopus itself, the Foxpro 
ODBC driver (which links the program to its database files), and the example database (which 
will enable you to view and edit the sample data supplied with this demonstration software). 
These default selections are the suggested ones for a first-time user of Octopus

8 Follow the directions when you are asked to insert diskettes 2 and 3

9 When the installation is complete, Octopus may ask you to restart Windows in order to save 
the changes it has made to the system files. Select restart Windows

10 When Windows has been restarted, there will be a new Octopus window in your Program 
Manager, with icons for Octopus and its utilities, plus the alarm and ODBC setup (see below). 

Remember to remove diskette number 3 from your floppy drive when you have completed the 
installation

3.2 Network server and workstations

1 To install Octopus onto a network server, follow the steps as described above for installation 
on a stand-alone computer. Remember that on a network, you may see a prompt for another 
drive (for example F:), rather than the C: drive

2 When you reach Step 6, you must specify network directory paths for the program and the data
(eg; Z:\OCTOPUS and Z:\OCTDATA)

3 To install Octopus onto network workstations, run the setup program using the same command
in Windows (File \ Run) as before, but you must set up from the network copy of Octopus 
already installed (eg; Z:\OCTOPUS\setup instead of A:\setup)

4 Octopus will automatically set up with the same options as were selected when the server 
installation was carried out

Note: On a network setup, workstation users should use shared locations for Word documents 
and templates and for Excel files (eg; Z:\OCTOPUS\DOCS or Z:\OCTOPUS\EXCEL). The 
locations for such files are specified via the Admin menu, under User Options / Word 
processor or User Options / Spreadsheet.
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4 Starting Octopus
4.1 Starting the program

1 Octopus will automatically copy the Alarm function into your Startup group, so that it is 
activated. If the alarm is not in your Startup group, double-click on the Alarm icon to activate 
it

2 Double-click on the Octopus icon to start the program

3 You will see an introductory screen displaying User and Password fields

4 This version of Octopus has been set up to include a demonstration user (demo). The demo 
user has full rights within the program, and does not need a password to access it. Press 
ENTER without typing in a password

4.2 Startup messages in Octopus

When Octopus is set up and running, you may be greeted by one or more pop-up Alarm 
messages on your screen:

· Alarm message: This will occur if the Alarm function has been activated, and an Alarm has 
been set to remind you of an action to be carried out. Press the Octopus button if you 
wish to respond to the alarm and record an action, or press OK to clear the message. 
Refer to Sections 8.4 - 8.6 for more details on the Alarm function.

· Urgent message: When you call up a database record, you may see a pop-up Urgent Message. 
These messages can be assigned to a particular company record on the database in order
to alert users to important information (for instance; the company is on credit hold or 
has special payment/delivery terms). Press OK to clear the message. Refer to Section 
7.7 for more information.

· Mail connection: This is explained in detail below (4.4 How to connect to your mail system)

Once you have cleared these pop-up messages (by following the procedures described above) -
or if no messages appear - you will see the screens described in Section 6.

4.3 Using Octopus

If you have not used Octopus before, we recommend that you read through Sections 6-8 which 
will give you an introduction to some of the main features of Octopus. You will find it useful 
if you follow the procedures described, to familiarise yourself with the software. 

Pages 10-11 give you an overview of the toolbar and menu functions - refer to these pages 
when you need to find a particular icon or menu option.

4.4 How to connect to your mail system

This section applies only to users in a workgroup or network environment - stand-alone PC 
users should skip this section. 

If you wish to connect Octopus to your electronic mail system (which you must do if you want 
to send automatic notifications to other network users), you must first start Octopus running as 
described above. 

1 From the Admin menu, click on Security / Users

2 Click to highlight the relevant user name (Demo User, in this case) and choose Edit

3 Complete the Email address, MAPI mail box and Mail password fields exactly as they are in 
your existing electronic mail set up

4 From the Admin menu, choose User Options

7



5 Click on to the Environment tab. The Mail Service field should be set to MAPI. The Connect 
field determines how Octopus will attempt to connect to your Email system, if at all, when you
start running it. It has three possible values which can be selected, Never, Ask and Always. 
These selections are detailed below.

· Never: If you choose Never, Octopus will not give you a startup message, and will not attempt
to establish a mail connection. 

· Always: Octopus will always try to connect you to the mail system, and if it fails, it will give 
you an error message explaining the failure to connect, and then continue running as 
normal. 

· Ask: Octopus will give you a startup message that asks if you wish to connect to the mail 
system. If you choose Yes, Octopus will attempt to establish a connection and if it fails it will 
give you an error message explaining the failure to connect, and then continue running as 
normal. If you choose No, Octopus will continue running as normal.

8



5 Octopus functions
5.1 The toolbar icons

First Next Find Save Action Query Label Merge Print Switch to
record record Excel

Previous Last Clear Delete Action Fire Mailout AutoDial Switch to
record record History Query Word

5.2 The menus
Displays a blank record form for the appropriate drawer

Allows you to preview a report before printing
Sends a report to print
Displays a list of the report options
Displays a dialogue box showing available printers, along with the options for changing printer setup
Exits Octopus

Cuts text from a field or text box and stores it in the clipboard

Copies text from a field or text box and stores it in the clipboard
Pastes text from the clipboard into a field or text box
Deletes text from a field or text box

Displays the first record in a database drawer

Displays the previous record in a database drawer
Displays the next record in a database drawer
Displays the last record in a database drawer
Searches for a record on one of the three key fields
Clears the current record from display
Saves updates and changes to a record
Deletes a record from the database
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Displays a list of available mail merge documents, with 
the option of adding to or changing the list

Enables you to define actions and their default next actions
Enables system manager to add users and groups, and allocate or edit users’ rights
Enables you to define and edit the database drawers 
Enables you to change your user password
Enables users to change the default setups
Toggles toolbar display on and off
Toggles status bar on and off
The parameters used by Octopus - should not be adjusted by users!

Allows you to record current actions and specify follow up 
actions

Displays the history of actions associated with a company
Displays the To Do List
Enables you to add a new contact to the database quickly
Enables you to create banner messages which pop up whenever the relevant record is displayed
Prints a mailing label for the displayed contact
Copies details from the displayed contact into a word processing merge file
Prints a mailing label and records the mailout
Enables you to dial a contact automatically via a modem attached to your computer
Sends Email messages to other users
Displays a list of received Email messages
Switches to Word for Windows software
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Switches to Excel software

Enables you to specify criteria for querying the database

Instructs Octopus to search according the specified query criteria
Saves the query criteria for future use
Displays a list of saved queries

Arranges the windows on screen in a cascade

Arranges the windows on screen horizontally
Arranges the windows on screen vertically
Arranges the icons in a window tidily
Shows the names of the open windows on screen; tick indicates the active window

Displays an index of help topics

Explains how to use the Help function
Displays information about Octopus
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6 Startup screen
When you start Octopus for the first time, the first screen displays a To Do List, and an 
untitled database record (see below). You can switch between the To Do List and the untitled 
database record by clicking on either one, and you can move these windows around the screen 
(refer to your Windows documentation for more information on manipulating windows on 
screen).

On-line messages Date and Current Data User Num
time display merge source name lock

Caps
Scroll

lock lock

If you accidentally hide the To Do List behind the database record, you can retrieve it by 
choosing To Do List from the Window menu. If you close the To Do List (by double-clicking 
on the close window box at the top left hand corner) you can retrieve it by choosing To Do 
List from the Action menu. 

The To Do List is created automatically from the actions and follow up actions that have been 
recorded on the system. When an item on the To Do List is highlighted, summary details of 
the action are shown in the area below the list.

Refer to Section 8 for more detailed information on the To Do List. The database is described 
in more detail overleaf, in Section 7.

NOTE: This version of Octopus has been supplied to you with fifty sample records already 
included in the system to enable you to start using it straight away. You can still enter your 
own data, or edit or delete the data supplied with the system, as long as the total number of 
records does not exceed fifty. The full version of Octopus can store an unlimited number of 
records - for more information, call: KAI Computer Services Ltd on 0171 609 3746.
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7 The database
7.1 Introduction to the database

Records in the Octopus database are stored in templates called ‘drawers’. These drawers are 
user-definable, so you can design your own template to meet your specific requirements.

Click on the untitled database record which is displayed on your startup screen. At the top 
right hand side of this record, you will see a field called Drawer. If you click on the down 
arrow to the side of this field, you will see a list of alternative drawers, each one designed to 
hold your information in a different way (for example, Clients/Prospects, Help Desk, 
Personnel, etc). Scroll down this list to view some of the other drawer designs.

tabs within a database drawer drawer selection field

 

Area for displaying actions associated with a database record

You will notice that each database drawer is designed with four pages (or ‘tabs’) of 
information in it. You can view any of these tabs by clicking on its title panel which is visible 
at the top of the window, rather like selecting a card from an index card box. Note the space at
the bottom of the first tab where you can choose to display (where appropriate) the last action 
or the next To Do associated with that particular record.

NOTE: Although you can move between the different tabs of a single record in this way, the 
option to choose a different drawer is only available on the first (left hand side) tab of any 
record. The current record must be cleared before the drawer selection option is available - 
refer to Section 7.4 for details on how to clear a record.
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7.2 Finding a record

Up to fifty records can be stored in this version of Octopus; we have included some sample 
records to help you get started. To find and view a sample record: 

1 Choose the Clients/Prospects drawer, by clicking on the first tab and scrolling down the list 
available in Drawer

2 Type the code AB into the Code field, and search for it by clicking on the Find icon (or press 
CTRL + F, or choose Find from the Record menu)

the Find icon

shaded fields are key search fields fields where text can be typed in

fields where values are selected from the drop-down list

Note: Octopus can search for records as described above using search values typed into one 
of the three key search fields; Code, Company, and Postcode. These key fields are shaded 
darker than other fields on the database (see above).

If there is only one match, Octopus will find the record for Abbey International. If there are 
several records with codes that match, a list will appear. Highlight Abbey International from 
the list, and double-click on it to display the record. Move through the four tabs of information
by clicking onto the title panel of each one. Some fields have a down arrow in the right hand 
side of the text box, which when pressed, displays a list of possible values for selection. Such 
fields can only be completed by selecting one of the values in this list. Other fields are 
completed by typing text into the box (see above).
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On the Notes tab, you will notice a map pin displayed on the title panel of the tab. This indicates to 
users that important information has been recorded in the Special Notice text box. 

map pin icon draws attention to important information on Notes tab

7.3 Querying by example

A list of all the records in Octopus can be viewed if you query by example without giving any 
search criteria. To query by example: 

1 Choose Query from the Record menu or press the Query icon. Octopus will present you with a
blank record with which you can specify your search criteria

2 Leave all the fields blank if you wish to view all existing records

3 On the first (Contacts) tab, place a checkmark in the box to the right of the Drawer field, so 
that all Drawers can be searched (not just the current Drawer)

the Query icon the Fire Query icon checkmark indicates a search on all drawers

4 Choose Fire Query from the Query menu or press the Fire Query icon to start searching
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5 Octopus will display a list of all the records on the database that meet the search criteria - in 
this case, all records will be listed since no search criteria were applied

6 If you double-click on an entry in this list, Octopus will display the record selected.  When 
you have browsed through the tabs of a sample record, you can return to the list of records by 
clicking on any part of it, or by choosing List from the Window menu

7.4 Adding a record

Note: This version of Octopus is restricted to an upper limit of 50 records. When the limit 
is reached, Octopus will prevent you saving new records or changes made to existing ones.

the Clear icon

1 Move to the Contacts tab and click the Clear icon, or choose Clear from the Record menu

2 Octopus will ask if you wish to clear only the Contact details or the Whole Record. Clear the 
whole record. If you are currently displaying an existing record (as opposed to one that you 
have deleted - see Section 7.5 below), Octopus will prompt you to save any changes you have 
made before it clears the record

Note: From any other tab except Contacts, when you choose Clear, Octopus will clear the 
whole record without offering you the option to clear just the contacts - although it will ask 
you if you want to save changes before clearing the record.
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3 Now you have a blank form to complete, like the one displayed when you first start Octopus

4 From the Contacts (or first) tab, select the drawer in which you want to enter the new record, 
by clicking the down arrow to the right of the drawer 

5 Move to the Company tab (the second one), and type in a company code. This code is 
automatically copied across to the three other tabs in that record

Note: The maximum number of characters in the Code field is ten. If you hear a bleep 
when typing data into a field, you have reached the maximum number of characters for 
that field.

6 When you have entered the telephone, fax and Email numbers on the Company tab, save the 
record. Then click on to the Contacts tab - you will find the telephone, fax and Email numbers
are automatically copied across to the relevant fields on this tab to save you retyping them

7 Now complete the data fields in the other tabs for this record. Remember to Save any changes 
by pressing the Save icon, or choosing Save from the Record menu

7.5 Adding additional contacts to an existing company record

If you want to add more than one contact to a single company: 

1 Display the appropriate company record on screen (either by searching for a particular 
company code, as described in Section 7.2; or by selecting from a list of existing companies, 
as described in Section 7.3)

2 Click onto the Contacts tab, and save any changes you have made to the record

3 Click on the Clear icon, or choose Clear from the Record menu. Clear the Contact details, not 
the Whole Record

4 Now you will have a second Contact tab associated with that company. Enter the details of the
second contact, and save it

the Clear icon the Save icon
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7.6 Deleting a record

To delete a record, you must first display it on screen by using Find or Query.

1 Implement the query by example steps as described in Section 7.3 to produce a list of all the 
companies on the database

2 If you have a list of companies, highlight the name of the record you wish to delete, and 
double-click on it to display the company record

3 When you have selected your record from the list or found a single record, choose Delete from
the Record menu, or click on the Delete icon

the Clear icon the Delete icon

4 If you are on the Contact tab, Octopus will ask you if you want to delete the Contact or the 
Whole Record. Choose Whole Record. If you are on one of the other tabs when you choose 
Delete, Octopus will delete the whole record without giving you the option of deleting just the
contact. Notice that when you delete a record, the data remains on the screen until you choose
to clear it

5 When you have deleted the record, click the Clear icon to clear the record details from the 
screen

7.7 Urgent Notice messages

You can create an Urgent Notice banner message that pops up on screen whenever the target 
record is viewed by any user. To do this: 

1 Display the record to be flagged, as described in Sections 7.2 and 7.3 above

2 From the Action... menu choose Urgent Notice

3 Octopus will present you with a box in which to type the text of your message (maximum 
number of characters for this message is 60)

4 Press OK. Octopus will automatically display the message on screen every time that record is 
viewed. You will be prompted to save the changes to this record before exiting it

To delete an Urgent Notice, simply display the relevant record, and choose Urgent Notice 
from the Action... menu again, and delete the text from the text box. Press OK to exit the 
Urgent Notice window, and save the changes to the record.

Note: If 60 characters is insufficient to record the information you want, remember that you 
can use the Urgent Notice to direct users to look at the Notes tab of the record, where you can 
store longer text, or use the Special Notice text box to display the map pin icon.
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8 Activity management
8.1 Introduction to Actions and To Do items

Actions are user-defined activities which describe the communication between yourself and 
your contacts. A list of actions in Octopus could include definitions of all types of 
communication, such as telephone calls, correspondence and meetings. Every action recorded 
in Octopus is linked to an individual database record, and can be viewed in the Action History 
of that record. We have supplied a ready-made list of actions to help you explore the 
possibilities of activity management.

Octopus allows Actions to be defined to include specific default values. For example, a user 
may want to define the action ‘Set Appointment’ to include an default follow up action (a To 
Do List item) of ‘Call Back’. To Dos are activities planned for the future.You may even want 
to specify the user to whom the To Do will be assigned, and ensure that Octopus automatically
completes the date and time fields specifying when the To Do item should be implemented. 
Once you have specified the To Do item, you can set an alarm for it, so that the relevant user 
will be alerted to the impending action.

8.2 Creating an action

1 Find the Abbey International record by clearing the current screen (choose Clear from the 
Record menu or press the Clear icon) and search for the code AB, as described in Section 7.2

2 Now move onto the Contacts tab of the Abbey International record. Suppose you want to note 
a telephone conversation with a contact at Abbey International. Celine is the main contact for 
this company, as shown by the checkmark in the box next to the Contact field

3 Press on the arrow next to this field to choose Brian as the contact for whom you will record 
an action

the Action icon

4 Choose Action... from the Action menu (or click on the Action icon on the toolbar, or press F2
to record a new action). Notice that the Action window has automatically chosen Brian in the 
Contact field, although you could now choose Celine by scrolling down the list. Press on the 
Action list arrow to select an action you want to record, for example, a Prospecting Call. 
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the Operators icon

Enter your comments or 
background notes on this 
action by typing them into 
the Comment field. The 
action and comments will 
be filed in the Action 
History for this database 
record

When you select Prospecting Call, notice that Octopus automatically creates a follow up 
action (a To Do, which will be recorded in the To Do List) of a Call Back and assigns a date 
to it

The default selections in the To Do area of the window are made because the Prospecting Call
has been user-defined to include this default follow up. You can choose not to record a To Do 
for this action, or you can define a different To Do from the default one - see Creating a To 
Do, below. 

8.3 Creating a To Do 

When you have recorded an action as described above, you can create a To Do List item by 
completing the appropriate fields in the To Do area of the Action window. Some Actions are 
defined to create a default To Do item automatically (refer to Section 8.1 above), in which 
case Octopus will complete the relevant fields for you. You can override the defaults and 
define an alternative To Do by scrolling down the Assign To and Action fields and selecting 
alternative values from the lists, and by typing over the default values in the date and time 
fields.

Octopus will automatically update the appropriate To Do List with that To Do item. If you 
want to record an action without specifying a To Do, make sure the date and time fields in the 
To Do area of the Action window are blank.

If you want to, you could now set an alarm to remind yourself of the impending call back.

Note: Network users of Octopus can define alternative users to whom actions can be 
assigned. To do this, press the Operators icon (next to the Action field in the Action 
window) and click on the Assign To box. Press Insert to view the possible users, and 
double-click on the user to whom you wish to assign the action. If you have a mail system 
installed, you can Notify other users of actions carried out. To do this, press the Operators 
icon, click on the Notify box, and press Insert. Select the user to be notified by double-
clicking on the name.

You can also assign follow up (To Do) actions to other users by selecting from the list in 
the Assign To field in the To Do area of this window. Octopus will update the relevant To 
Do Lists accordingly.
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PLEASE NOTE: the Notify function ONLY works with a MAPI-compliant mail system 
installed on the network. If there is not one installed, you will receive an error message, 
telling you that Octopus failed to send the notification.

21



8.4 Setting the alarm

Alarms are always associated with To Do List items - refer to Sections 8.1 - 8.3 above. In 
order to use the alarm, the Alarm function must be active (see Section 4.1 Starting the 
program, point 1). To set an alarm: 

1 Record the To Do item as described above

2 Type in the date (if the default date is not the one you want) using numbers (31/03/95) or 
words and numbers (31 Mar 1995)

3 Enter the time you want to start implementing the To Do in 24-hour clock format

4 Now click on the Set Alarm box, and type in how many minutes warning you want before the 
action is due to take place. Then press OK.

8.5 Reviewing or implementing an item on the To Do List

If you double-click on one of the entries in the To Do List, Octopus will create a new Action 
window, displaying the comments that were recorded when the To Do was created. Notice that
in this Action window, the To Do has been redefined as a current action  - Octopus is ready to 
record the results of implementing the To Do. You may wish to review an entry on the To Do 
List without implementing it - in this case, press Cancel to clear the Action window.

If you want to implement the To Do item, then complete the Action window and record the 
action in the usual way (see Creating an action, Section 8.2). Press OK to save the details you 
have recorded and to record the action as part of the Action History of the company.

Note: If you press OK in order to clear the Action window, Octopus assumes that you have 
now implemented the To Do and so will delete it from your To Do List. You can also delete
To Do List items by highlighting them and clicking the Delete icon on the toolbar.
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8.6 Responding to alarms

When the alarm is activated, a pop-up message box will appear on the screen, showing the 
comments that were recorded when the alarm was set.

1 Press OK if you wish to close the box without acting on the reminder

2 Press the Octopus button if you intend to implement the action of which you have just been 
reminded. This will create a new Action window in which you can record the Call Back you 
are making, along with any comments or additional information. You can also create another 
To Do if required

3 Press the Snooze button to clear the alarm box for ten minutes, after which it will reappear to 
remind you 

4 Press the Timer button to alter the snooze period

8.7 Reviewing the Action History

To review a company’s action history, select Action History... from the Action menu, or click 
on the Action history icon on the toolbar. 

the Action History icon

Double-clicking on any entry in this list will display the data that was originally typed in when 
the action was first recorded. This Action History window builds up into a detailed report of your 
communication with any database contact over time, enabling you to review in detail your 
customer and supplier accounts as they develop.

  
9 Backing up your data
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As with any software application, you should make regular backups of your data, in order to 
minimise the chances of any loss of data or interruption to your business should anything go 
wrong with your computer system.

On a stand-alone computer, the default directory path which stores most of the data associated 
with Octopus software is C:\OCTDATA. You should also backup the main C:\OCTOPUS 
directory, as some data files are stored here. Remember, though, that you may have specified 
different directories and paths when you installed Octopus.

Network users should backup the appropriate directories and paths as specified when Octopus 
was installed.

Refer to your system software documentation for more information on backing up your data.

24



10 Overview of some other Octopus features and shortcuts:

1 Customising or creating your own database drawers
Accessed through: Admin / Drawer Maintenance menus

2 Defining or editing custom actions for your Action list
Accessed through: Admin / Actions menu

3 Quick Entry for a new database contact 
(very useful for incoming calls, when you don’t have time to create a new record)
Accessed through: Action / Quick Entry menu
Keyboard shortcut: F4

4 Create an Action
Accessed through: Action menu
Keyboard shortcut: F2 (can use icon on toolbar)

5 Creating or editing users and rights
Accessed through: Admin / Security menu
Keyboard shortcut: None

6 Print label
Accessed through: Action / Label menu
Keyboard shortcut: None (can use icon on toolbar)

7 Create Urgent Notice banner
(messages that pop up whenever a particular record is displayed - for special payment terms, 
etc)
Accessed through: Action / Urgent Notice menu

8 AutoDial
(Octopus automatically records the time taken for an action using the AutoDial feature)
Accessed through: Action / AutoDial menu
(Can use icon on toolbar)

Please note that this option only works with an installed modem/handset attachment

9 Switch to Word for Windows
Accessed through: Action / Word for Windows menu
Keyboard shortcut: None (can use icon on toolbar)

Please note that in order to use the merge functions with your word processor, you must have 
some word processing documents already set up to receive the merge information. We supply 
some sample templates; in order to establish the links between Octopus and these templates, 
you should refer to your word processing documentation.

10 Switch to Excel
Accessed through: Action / Excel menu
Keyboard shortcut: None (can use icon on toolbar)
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OCTOPUS DEMONSTRATION SOFTWARE - TERMS OF USE

Notice: You are authorised to access and use the OCTOPUS software only if you have entered into a 
Pre-Release Agreement with KAI Computer Services Limited, London N7 9AH. Your use of the 
software is subject to the terms of such Agreement.

The pre-release version of OCTOPUS (“PRODUCT”) is proprietary to KAI and its suppliers. You 
may not reverse engineer, decompile, or disassemble the PRODUCT. You may not sell, rent, lease or
otherwise transfer the PRODUCT. You must use and return or destroy all copies of the PRODUCT 
and related materials upon the earlier of either (a) KAI’s written notice to you, (b) the commercial 
release of the PRODUCT by KAI, or (c) one year after receipt of the PRODUCT by you. The 
PRODUCT and Documentation are not in final, commercial form and are provided “as is” without 
warranty of any kind to the maximum extent permitted by applicable law, KAI and its suppliers 
disclaim all implied warranties including without limitation any implied warranties of 
merchantability or of fitness for a particular purpose.

The entire risk arising out of the use or performance of the PRODUCT and documentation remains 
with you. In no event shall KAI or its suppliers be liable for any damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use the PRODUCT or 
documentation, even if KAI has been advised of the possibility of such damages. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental 
damages, the above limitation may not apply to you.

Governed by the laws of England and Wales.

Refer to your Pre-Release Agreement for further terms and conditions.
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